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Installazione di EthoVision XT

Per installare EthoVision XT

1. Andate al sito

 https://my.noldus.com/download/latest/ethovision-xt

2. Effettuate il log in o registratevi utilizzando il codice sulla lettera che 
avete ricevuto da Noldus.

3. Nella sezione Versions, scaricate il file completo di installazione.

4. Estraete i file dal file zip e salvateli sul vostro PC.

5. Cliccate due volte il file EthoVision XT - Setup - [numero di 
versione].exe.

6. Seguite le istruzioni sullo schermo. Presso l’opzione Installation 
type, selezionate Standard.

Note

 Per utilizzare telecamere con EthoVision XT, installate prima di 
tutto i drivers delle telecamere sullo stesso computer. Per i dettagli, 
premete F1 in EthoVision XT e cercate Camera Installation 
nell’aiuto in linea.

 Se scaricate i files di installazione su di una unità di rete o un disco 
esterno, copiate i files sul vostro PC e soltanto successivamente 
avviate l’installazione con il file EthoVision XT - Setup - [numero di 
versione].exe.
Installazione di EthoVision XT 3

https://my.noldus.com/download/latest/ethovision-xt


4

Attivate la vostra licenza

con una chiave di licenza usb

Se avete una chiave di licenza USB, inseritela in una porta USB del 
computer e avviate EthoVision XT. 

Se aggiornate la vostra licenza EthoVision XT, inserite il codice Upgrade 
key nella finestra che appare.

con una chiave di licenza software

Se avete ricevuto una chiave di licenza software, avviate EthoVision XT 
e attivate la licenza. Scegliete tra una licenza flessibile (Floating)  o una 
licenza fissa (Computer-locked).

 Floating — Usate questa licenza se volete essere flessibili nell’uso 
del computer su cui acquisire i dati con EthoVision XT. I vostri 
computer devono essere connessi a Internet.

 Computer-locked — Questa licenza è associata ad un computer 
specifico. Per attivare la licenza, il computer deve disporre di una 
connessione Internet oppure è necessario disporre di uno 
smartphone con una connessione Internet. 
Attivate la vostra licenza



Il vostro primo esperimento con 
EthoVision XT

creare un esperimento

EthoVision XT crea un esperimento basandosi sulle opzioni da voi 
scelte durante la procedura riportata qui sotto. Per esempio, con quale 
specie animale intendete lavorare, di che tipo di test si tratta, etc. 

1. Nella finestra EthoVision XT, sotto New experiment, cliccate New 
from template o scegliere File > New from Template.

2. Selezionate Apply a pre-defined template e seguite le istruzioni.

3. Nella finestra New Experiment, inserite il nome (Name) del vostro 
esperimento.

4. Scegliete dove salvare l’esperimento (Browse). Infine cliccate OK.

5. Siete pronti per completare l’impostazione dell’esperimento. In 
particolare, vedete le sezioni Arena Settings e Detection Settings. 
Come opzione, create una lista delle registrazioni (Trial List) e 
specificate i criteri per iniziare e terminare automaticamente le 
registrazioni (Trial Control Settings).
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Note

 Se il test che desiderate condurre non appare nella lista dei 
template, create un esperimento di default (File > New). Specificate 
poi le impostazioni che si adattano al vostro test.

 Per creare un esperimento da utilizzare insieme alla camera di 
osservazione DanioVision, nella finestra New Experiment 
selezionate l’opzione DanioVision experiment.

lavorare con gli esperimenti di ethovision xt

In EthoVision XT, un esperimento è il contenitore di tutte le 
informazioni riguardanti un test sperimentale. Il pannello a sinistra, 
detto Experiment Explorer, mostra il contenuto dell’esperimento 
(Figura 1).

Figura 1  Componenti di un esperimento in EthoVision XT. 1. Experiment Settings 
(impostazioni generali che non cambiano durante l’esperimento). 2. Arena 
Settings per disegnare l’arena e le zone. 3. Detection Settings per seguire il 
soggetto mentre si muove. 4. Acquisition per acquisire i dati. 5. Data profiles per 
selezionare i dati. 6. Analysis profiles per specificare le variabili da calcolare 
(velocità, etc.). 7. Opzioni dei risultati (numerici e grafici).
Il vostro primo esperimento con EthoVision XT



L'esperimento viene salvato per default in: C:\Users\Public\Public 
Documents\Noldus\EthoVision XT\Experiments\.

L’esperimento si trova in una cartella che porta lo stesso nome 
dell’esperimento.

Per copiare un esperimento, utilizzate sempre la funzione Backup 
(vedere copiare un esperimento a pagina 32).

nota  I “settings” ed i “profiles” sono insiemi di impostazioni che 
riguardano una funzione specifica. È possibile definire varie 
configurazioni e poi specificare quale configurazione utilizzare per 
ciascuna sessione di acquisizione dei dati (trial). Per esempio in un 
certo esperimento con il labirinto di Morris, per un primo gruppo di 
trials, verrà utilizzato Arena Settings 1 con la piattaforma definita in un 
certo quadrante. Per i trials di un altro gruppo, verrà utilizzato Arena 
Settings 2 dove la piattaforma è stata definta in un altro quadrante.
Il vostro primo esperimento con EthoVision XT 7
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Impostazioni generali 
dell’esperimento

experiment settings

Selezionate Setup > Experiment Settings.

Impostate le varie opzioni descritte qui sotto. A seconda della vostra 
licenza di EthoVision XT, alcune opzioni potrebbero non essere 
disponibili.

nota  Se avete creato un esperimento da template, la maggior parte 
delle caratteristiche dell’esperimento sono già stabilite.

Video Source

Specificate se volete analizzare files video già registrati (From video 
file) o l’immagine dal vivo (Live tracking). Per la seconda opzione, 
scegliete le telecamere che intendete utilizzare. 

Number of Arenas (Numero di arene)

L’ arena è uno spazio chiuso dove uno o più soggetti si muovono 
liberamente. Specificate il numero di arene visibili nell'immagine 
video. Per esempio, 1 se la telecamera è puntata su un water maze, 2 se 
è puntata su 2 open fields separati. 

Number of subjects per arena (Numero di soggetti per arena)

Selezionare quanti soggetti sono presenti contemporaneamente in una 
arena. Per esempio, 1 per il water maze, 2 per un test di interazione tra 
due individui. 

Nota: Dal momento che questa Guida si limita alla versione Base di 
EthoVision XT, l’esperimento contiene un solo soggetto per arena. 

Tracked Features (Caratteristiche rilevate)

Selezionare quali punti del corpo dei soggetti si desidera rilevare: 
soltanto il centro del corpo, oppure il centro del corpo insieme al naso e 
alla base della coda. 
Impostazioni generali dell’esperimento



Body Point Detection Technique (tecnica di riconoscimento dei punti 
del corpo)

Per eseguire il tracking dei punti del corpo “naso” e “base della coda”, 
selezionare la tecnica preferita: il contorno del soggetto (Contour-
based) oppure una rete neurale (Deep learning). La seconda opzione è 
applicabile ai soli roditori, con un solo soggetto per arena, e richiede 
l’installazione di una scheda grafica speciale.

Analysis options

Selezionare Activity analysis per eseguire l’analisi dei cambiamenti 
dell’immagine video, utile per esempio per riconoscere il 
comportamento di freezing. 

Con l’opzione Behavior recognition potete registrare 
automaticamente comportamenti dei roditori, come rearing e 
grooming.

Units (unità di misura)

Selezionare le unità di misura preferite. 

Quali opzioni sono effettivamente disponibili dipende dalla vostra 
licenza di EthoVision XT (Help > About EthoVision XT > License Info). 
Per informazioni, vedere Modules of EthoVision XT nell’aiuto in linea.
Impostazioni generali dell’esperimento 9
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Definire le arene e le zone

Definite in EthoVision XT in quale regione dell’immagine video il 
soggetto si muove (arena). Se avete creato un esperimento da un 
template, l’arena è stata già creata. Cambiatene la dimensione e/o la 
posizione per farla coincidere con l’arena nel video.

Per ottenere una immagine di sfondo

1. Nel caso di video-tracking dal vivo, accertarsi che la telecamera sia 
accesa e connessa al computer. 

2. Selezionare Setup > Arena Settings. Aprire Arena Settings 1 
(predefinito) o creare un nuovo profilo “Arena Settings”.

Nel caso di video-tracking da files video, cliccare Browse e aprire il 
file video da utilizzare per disegnare l’arena.

3. Cliccare Grab.

Per disegnare una arena

1. Cliccare 1. Draw Scale to Calibrate nella finestra Arena Settings.

2. Tracciare una linea tra due punti dell’arena posti ad una distanza 
reciproca conosciuta. Nella finestra che compare sullo schermo, 
digitare il valore della distanza reale tra i due punti (nella unità di 
misura scelta in Experiment Settings) e cliccare OK. Ripetere questa 
procedura alcune volte e in entrambe le dimensioni per ottenere una 
calibrazione più accurata.
Definire le arene e le zone



3. Cliccare 2. Select Shape and Draw Arena nella finestra Arena 
Settings. 

4. Utilizzare uno o più degli strumenti di disegno per disegnare la 
regione dell’immagine video nella quale si muove l’animale. 
Accertarsi che la freccia dell’etichetta Arena sia all’interno di questa 
regione.

Note

 Per ulteriori dettagli, vedere Arena Settings nell’aiuto in linea.

 Se lavorate con DanioVision, consultate il manuale DanioVision 
DVOC-0041 - Reference Manual per dettagli sulle arene.
Definire le arene e le zone 11



12
Per disegnare le zone

Una zona è una regione dell’arena che desiderate utilizzare ai fini 
dell’analisi o per iniziare o terminare automaticamente l’acquisizione 
dei dati. Se avete creato un esperimento da template, diverse zone sono 
già definite. Se necessario, modificatene la forma, dimensione e 
posizione, oppure create nuove zone.

1. Cliccate 3. Select Shape and Draw Zones nella finestra Arena 
Settings.

2. Scegliete uno degli strumenti di disegno.

3. Tracciate il contorno della zona.

4. Assegnate alla zona un nome.
Definire le arene e le zone



Definire il controllo del trial 
(facoltativo)

Scopo delle impostazioni Trial Control

Specificare le regole che controllano l’inizio e la fine automatica 
dell’acquisizione dei dati.

Impostazioni di default

Scegliete Setup > Trial Control Settings. Aprite il profilo di default Trial 
Control Settings 1.

 Nell’impostazione di default, l’inizio dell’acquisizione avviene 
quando il soggeto è rilevato per un secondo nell’arena, e termina 
manualmente.

 Se avete creato un esperimento da un template, le impostazioni 
sono state modificate in base a quel template. Per esempio, in un 
esperimento per il labirinto di Morris, il video-tracking termina 
quando l’animale viene rilevato sulla piattaforma per almeno 5 
secondi, oppure quando l’animale nuota per due minuti senza aver 
trovato la piattaforma.

Per programmare l’avvio del video-tracking

1. Nella seconda casella, cliccate Settings.

2. Se volete avviare il video-tracking quando l’animale si trova in una 
zona particolare,  nella finestra cliccate Settings, de-selezionate 
Arena e selezionate quella zona.

3. Se necessario, modificate il criterio da utilizzare (per esempio, 
frequenza di occorrenza invece di durata).
Definire il controllo del trial (facoltativo) 13



14
Per programmare il termine del video-tracking

1. Nella casella a monte della casella Stop track, cliccate Settings.

2. Per terminare il video-tracking dopo un certo tempo trascorso 
dall’avvio, selezionate After, e specificate il tempo desiderato.
Definire il controllo del trial (facoltativo)



Note

 La prima casella, Start Trial, indica il momento in cui premete il 
tasto Start Trial. La casella Start track indica il momento in cui inizia 
l’effettiva acquisitione dei dati (tracking).

 Per regole di avvio/termine più complesse, per esempio “termina il 
video-tracking quando il soggetto raggiunge la piattaforma”, 
sostituite la condizione Time con una condizione In zone, e 
specificate la zona “piattaforma”. Per altri esempi vedere Trial 
Control nell’aiuto in linea.

 Prima di avviare il trial, assicurarsi che il profilo Trial Control 
Settings che si intende utilizzare sia selezionato nella finestra 
Acquisition Settings.

 Con il modulo Trial and Hardware Control, potete controllare 
dispositivi (luci, dosatori di cibo, ecc.). Per esempio, produrre uno 
stimolo luminoso quando l’animale entra in una zona specifica. È 
anche possibile creare delle routines, per esempio in esperimenti di 
condizionamento.
Definire il controllo del trial (facoltativo) 15
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Regolare le impostazioni di 
rilevamento

1. Selezionate Setup > Detection Settings. Aprire Detection Settings 1 .

2. Se lavorate con files video, presso Video cliccate Select Video per 
aprire un file video. Riproducete il video fino a quando l’animale 
compare nell’immagine. Se lavorate con la telecamera dal vivo, 
rilasciate l’animale nell’arena.

3. Cliccate Automated Setup. Scegliete il tipo di animale e cliccate 
Next.

4. Aspettate fino a quando il soggetto non è in contatto con oggetti o 
pareti e cammina normalmente. A quel punto, tracciate un 
rettangolo intorno al soggetto (o a ciascun soggetto se si lavora con 
diversi animali nella stessa arena simultaneamente).

consiglio  Se lavorate con i roditori, cercate di lasciare la coda fuori 
dal rettangolo. In tutti gli altri casi, includete la coda del soggetto.

5. Se il corpo dell’animale è rilevato correttamente (e evidenziato in 
giallo), cliccate Yes. In caso contrario, provare a spostare l’indicatore 
Finetune da una parte o dall’altra. Assicuratevi che l’area gialla 
copra il corpo intero dell’animale (tranne la coda nei roditori).
Regolare le impostazioni di rilevamento



Se il rilevamento non migliora, cliccate No e di seguito Advanced nella 
finestra Detection Settings. Per ulteriori dettagli, nell’aiuto in linea (F1) 
consultate Configure Detection Settings > Advanced Setup.

Rilevamento del naso e della base della coda

 Assicuratevi che l’intero corpo dell’animale venga rilevato.

 Se usate la tecnica Deep learning con un solo soggetto per arena, 
nell’area Method cliccate Define e selezionate un’area intorno al 
soggetto, come in questo esempio.

Note

 Controllate che i soggetti siano rilevati ovunque nell’arena. Nel 
pannello Detection Performance, verificate che i campioni con 
Subject not found siano a livelli accettabili (per es. meno del 5%).

 Se avete selezionato Activity analysis nelle impostazioni 
Experiment Settings per rilevare il comportamento di freezing, 
cliccate Activity. Modificate le impostazioni fino a che la maggior 
parte dei pixels marcati in viola appaiono soltanto quando 
l’animale si muove.
Regolare le impostazioni di rilevamento 17
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Preparare una lista di trials 
(facoltativo)

In EthoVision XT, un Trial è una sessione ininterrotta di acquisizione dei 
dati, indipendentemente da quanti soggetti e quante arene vengano 
utilizzate contemporaneamente. Se avete creato un esperimento 
template, uno o più trials pianificati (planned) sono stati aggiunti 
automaticamente, e i valori delle variabili indipendenti sono stati per 
essi specificati a titolo di esempio. 

Come aggiungere dei trials alla Trial List

1. Selezionare Setup > Trial List. Cliccare Add Trials. 

2. Digitare il numero di trials pianificati e cliccare OK.

3. Per ciascun trial (sulle righe della tabella):
- Inserire i valori della variabile indipendente secondo il protocollo 

stabilito. Per esempio, nella cella della variabile “Trattamento” 
per il Trial 1 - Subject 1 inserite il valore “Placebo”.

- Specificate il file video nella colonna System - Video file (solo se si 
esegue il tracking da files video).

- Cliccare il tasto Show/Hide e di seguito Variables. Selezionare 
Arena Settings, Trial Control Settings, e Detection Settings.

Figura 2  Una trial list con 10 sessioni (trials) da acquisire.
Preparare una lista di trials (facoltativo)



definire le variabili indipendenti

Cosa sono le variabili indipendenti?

Le variabili indipendenti possono essere semplici categorie descrittive 
(come il genotipo o l’età dei soggetti), o condizioni manipolate dal 
ricercatore (come la sostanza da testare e la dose iniettata). Definite 
queste variabili nella Trial List.

Se avete creato un esperimento predisposto (da template), una o più 
variabili indipendenti sono pre-definite nella Trial List. Per esempio, per 
l’esperimento ottenuto dal template ‘Open field, circle’ con le zone 
‘Border, center, quadrants’ predefinite, trovate due variabili 
indipendenti: Animal ID e Treatment. 

Per aggiungere una variabile indipendente

1. Selezionare Setup > Trial List.

2. Cliccare Add Variable. Apparirà una nuova colonna sul lato destro 
della tabella. 

3. Specificare il nome (Label), una descrizione (Description; 
facoltativa), il tipo (Type; per esempio, testo o numerico), il formato 
(Format), eventuali valori predefiniti (Predefined values; per 
esempio, 0.01, 0.02 ecc. mg/kg per la variabile “Dose”), e la portata 
(Scope; specificare se i valori della variabile possono differire tra 
soggetti in una stessa arena (scegliere Subject), tra arene in uno 
stesso trial (Arena), oppure tra diversi trials (Trial)).
Preparare una lista di trials (facoltativo) 19
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Acquisizione dei dati

metodi

Selezionare Acquisition > Open Acquisition. Nella sezione Method, 
selezionare il metodo di acquisizione che si desidera applicare. 

Se eseguite il video-tracking da files video esistenti

Cliccate il tasto Video e aprite il video che volete utilizzare.

Se eseguite il video-tracking dall’imagine dal vivo:

Per eseguire il video-tracking e contemporaneamente registrare il 
video, scegliete Track next planned trial e Save video. EthoVision XT.

Per le altre opzioni, vedere Acquire Data nell’aiuto in linea.
Acquisizione dei dati



procedura di acquisizione (un trial)

1. Nella sezione Settings, scegliete le impostazioni Arena Settings, 
Trial Control Settings, e Detection Settings da utilizzare per quel 
trial, se non erano già state definite nella Trial list. 

2. Cliccate il tasto Add Trial nella finestra Playback Control 
(se disponibile). Altrimenti andate al passo successivo.

3. Se il tracking viene eseguito da files video, e non si 
intende codificare comportamenti manualmente, selezionate 
l’opzione DDS (Detection Determines Speed) nella finestra Playback 
Control. Con l’opzione DDS non si corre il rischio che EthoVision XT 
salti dei campioni dovuto alla mancanza di tempo necessario al 
rilevamento.

4. Per avviare il trial, cliccate il tasto Start trial nella finestra 
Playback Control.

5. Per terminare il trial, cliccare il tasto Stop trial.

Note

 È possibile avviare e terminare il trial automaticamente, a seconda 
del comportamento e della posizione del soggetto (vedere  a pagina 
13).

 Per acquisire una serie di trials uno dopo l’altro automaticamente, 
dal vivo o da un gruppo di files video, consultate Batch data 
acquisition nell’aiuto in linea. 

 È possibile registrare comportamenti manualmente, sia surante 
l’acquisizione del trial, che successivamente mediante la 
riproduzione del video. Vedere Manual Scoring Settings e Score 
behaviors manually nell’aiuto in linea.
Acquisizione dei dati 21
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Correzione dei dati

Alcune volte EthoVision XT rileva un riflesso al posto del soggetto, 
confonde la punta del naso con la base della coda o scambia i soggetti 
che si muovono nella stessa arena. In casi simili, è possibile modificare i 
tracciati per correggere questi errori. Selezionate Acquisition > Edit 
Tracks.

Per maggiori informazioni, consultate Edit Tracks nell’aiuto in linea.
Acquisizione dei dati



Calcolo delle statistiche

preparare i tracciati

Un tracciato (track) è il gruppo di campioni acquisiti per un soggetto. 
Per avere una stima affidabile del movimento dell’animale, e 
rimuovere l’effetto del rumore di sistema e dell'oscillazione del corpo 
in movimento sul tracciato (body wobble), è possibile perequare i 
tracciati (smooth the tracks).

1. Selezionate Acquisition > Track Smoothing Profile. Selezionare 
Open e cliccare OK.

2. Selezionate una o più delle seguenti opzioni: Smoothing (Lowess), 
Minimal Distance Moved, e Maximal Distance Moved.

Per maggiori informazioni, consultate Smooth the Tracks nell’aiuto in 
linea.

profili di analisi

Selezionate Analysis > Analysis Profile > New. Assegnate un nome al 
profilo di analisi e cliccate OK.

Distance moved e Velocity sono predefinite come variabili dipendenti. 
Per aggiungere una variabile in un profilo di analisi, cliccate il tasto 
vicino al nome di quella variabile.

importante Se avete creato un esperimento da template, alcuni profili 
di analisi sono già definiti. Per esempio, un esperimento da template 
per il labirinto di Morris con la piattaforma contiene quattro profili di 
analisi. Uno di essi, Latency to reach platform, contiene le variabili per 
calcolare il tempo impiegato per raggiungere la piattaforma.
Calcolo delle statistiche 23
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calcoli semplici

1. Aprite il profilo di analisi, e seguite le istruzioni qui sotto:

Distanza percorsa totale o velocità media

2. Cliccate due volte la variabile indipendente (per es. Distance moved). 
Nella pagina Trial Statistics, selezionate Total. Per la velocità, 
scegliete Mean.

3. Selezionate Analysis > Results > Statistics and Charts.

Tempo trascorso in una zona e numero di visite

1. Cliccate il tasto vicino a In zone. Specificate la zona. Nella pagina 
Trial Statistics, selezionate Cumulative duration e Frequency.

2. Selezionate Analysis > Results > Statistics and Charts.

Tempo prima di raggiungere una zona

1. Cliccate il tasto vicino a In zone. Specificate la zona. Nella pagina 
Trial Statistics, selezionate Latency to first.

2. Selezionate Analysis > Results > Statistics and Charts.
Calcolo delle statistiche



Distanza percorsa o velocità all’interno di una zona

1. Selezionate Analysis > Data Profile > New. Nell’ultima casella, 
cliccate Settings, e selezionate Results per zone. Scegliete la zona o 
le zone a cui siete interessati.

2. Aprite un profilo di analisi. Scegliete la variabile da calcolare (per es. 
Distance moved). Nella pagina Trial Statistics, selezionate la 
statistica (per es. Total).

3. Selezionate Analysis > Results > Statistics and Charts.

Risultati

La pagina Trial Statistics mostra i risultati per ciascun trial. La pagina 
Group Statistics & Charts mostra le statistiche e i grafici per tutti i 
trials, oppure i gruppi di trials definiti del profilo dei dati (Data Profile).

calcoli in serie (batch calculation)

È possibile eseguire calcoli multipli utilizzando combinazioni di Data 
profiles, Analysis profiles e Track Smoothing profiles in una sola volta. A 
tale, cliccare il tasto Batch.

Vedere Altre opzioni di analisia pagina 28 e Introduction to Data 
Analysis nell’aiuto in linea.
Calcolo delle statistiche 25
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Visualizzazione dei dati

visualizzazione 
semplice dei tracciati

Nel pannello Experiment Explorer, 
sotto Results cliccate Track 
Visualization per visualizzare e 
confrontare i tracciati. Con i tasti della 
finestra Playback Control è possibile 
far scorrere i tracciati per simulare il 
movimento dei soggetti.

Per visualizzare l’intero tracciato

Nel pannello a destra, sotto Filter 
rimuovete la selezione dell’opzione 
Last … seconds, e cliccare il tasto Jump to end nella finestra Playback 
Control.

visualizzazione integrata

Selezionate Analysis > Results > Plot Integrated Data per visionare un 
tracciato con il video corrispondente (se questo è stato registrato) e i 
grfici temporalli delle variabili dipendenti (velocity, etc.).

Per visualizzare una variabile dipendente

Aprite un profilo di analisi e aggiungete la variabile (vedere a pagina 
23). Di seguito, selezionate Analysis > Results > Plot Integrated Data.
Visualizzazione dei dati



mappe di distribuzione (heatmaps)

Con la funzione Heatmap Visualization potete creare mappe della 
distribuzione del soggetto durante uno o più trials. In questo modo si 
ottiene una impressione immediata di dove il soggetto trascorre più 
tempo. Per creare una mappa di distribuzione, selezionate Analysis > 
Results > Plot Heatmaps, e di seguito cliccare il tasto Plot Heatmaps 
nella barra degli strumenti.
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Altre opzioni di analisi

selezionare e raggruppare i tracciati

Selezionare Analysis > Data Profile > New.

Per analizzare alcuni tracciati, non altri

1. Scegliete una delle opzioni Filter. Per esempio:
- Scegliete Trial Name and selezionate i trials da analizzare.

- Scegliete Dosage (una variabile indipendente definita in 
precedenza; vedere la Figura 2 a pagina 18) e selezionate i valori di 
dose che volete analizzare.

2. Inserite la casella Filter tra le caselle Start e Result 1.

Per analizzare i tracciati in gruppi

Per  esempio, volete confrontare i valori di distanza percorsa tra gli 
animali trattati con una sostanza e quelli di controllo. 

1. Create un filtro per il primo gruppo tra la casella Start e la casella 
Result 1 (vedere sopra). 

2. Per creare il secondo gruppo, cliccare il tasto Result sotto Common 
elements. Trascinate il mouse dal centro della casella Start al centro 
della casella Result. Le due caselle sono così collegate da una linea. 
Create un nuovo filtro, questa volta per l’altro gruppo, e posizionate 
la nuova casella Filter lungo la linea di collegamento.
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3. Selezionate Analysis > Results > Statistics and Charts. Cliccate la 
pagina Group Statistics and Charts per visionare i risultati.

Analizzare segmenti all’interno dei tracciati

Per esempio, analizzare soltanto i primi 5 minuti del tracciato, oppure 
visualizzare tutti i campioni quando il soggetto si stava muovendo ad 
una velocità superiore a X, oppure quando faceva grooming.

Selezionate Analysis > Data Profile > New.

Nesting

Per selezionare segmenti basati sul tempo, sulle zone oppure sugli stati 
del soggetto, cliccate il tasto appropriato sotto Nesting e specificare il 
criterio che definisce l’intervallo. Per esempio, per analizzare i primi 5 
minuti, scegliere Time.
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Time bins

Per analizzare intervalli regolari di tempo, nella casella Result 1 cliccate 
Settings e selezionate Results per time bin. Specificare per es. 5 per 
analizzare intervalli di 5 minuti.

Di seguito, selezionate Analysis > Results > ... (a seconda del tipo di 
analisi).

Per maggiori informazioni, vedere Analyze Track Segments nell’aiuto 
in linea.
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Esportazione dei dati e dei 
risultati

procedura generale

Per verificare se le variabili indipendenti come il trattamento, la dose 
della sostanza iniettata nei soggetti, ecc. hanno avuto un effetto 
significativo sulle variabili dipendenti, esportate i dati e i risultati in un 
programma di statistica.

È possibile esportare:

 Le statistiche descrittive (Statistics), sia quelle calcolate per trial 
(Trial Statistics) che quelle dei gruppi (Group Statistics).

 I dati grezzi (Raw data): le coordinate x,y e l’area della superficie del 
soggetto registrate ad ogni campione. 

 I valori delle variabili dipendenti definite nel profilo di analisi, 
calcolati per ciascun campione.  
Nota: Dal momento che un tracciato contiene solitamente 
centinaia o migliaia di campioni, i file esportati contengono un 
grande numero di righe. 

 I comportamenti codificati manualmente, in forma di Manual 
Scoring log.

1. Selezionate Analysis > Export, di seguito:
- Statistics per esportare le statistiche descrittive, oppure

- Raw Data per esportare le coordinate X,Y, i valori delle variabili 
dipendenti per ciascun campione, o i comportamenti codificati 
manualmente.

2. Inserite un nome per il file di esportazione e scegliete il formato 
(testo o Excel). Di seguito, cliccate OK o Start export.
Esportazione dei dati e dei risultati 31



32
copiare un esperimento

Per creare una copia di un intero esperimento, per esempio per 
trasferirlo su un altro computer, selezionate File > Make Backup.

Il file di backup (*.evz) contiene tutte le vostre impostazioni e i vostri 
dati, e, a scelta, anche i files video, i files esportati e i dati esterni.

Copiate poi questo file in un altro computer in cui EthoVision XT è 
installato. Per aprire l’esperimento su questo computer, selezionate 
File > Restore Backup.

nota  Vi consigliamo di creare un backup dei vostri esperimenti almeno 
una volta al giorno, e salvare questo file su un hard disk esterno oppure 
sulla vostra rete locale.
Esportazione dei dati e dei risultati



Per ulteriori informazioni

Altri manuali

In EthoVision XT, selezionate Help > Help Topics o premete F1 per 
accedere all’aiuto in linea. Vedete inoltre gli altri manuali sul vostro 
computer. Dal menu Start di Windows, scegliete All Apps > Noldus > 
EthoVision XT 18 Other Documentation.

Gli esperimenti di esempio

Selezionate File > Restore Backup e aprite la cartella C:\Users\Public\ 
Documents\Noldus\EthoVision XT\Experiments\Sample Experiments. 
Troverete l’esperimento di esempio Morris water maze test XT180.evz. 

Per scaricare altri esperimenti di esempio, andate al sito 
my.noldus.com. Effettuate il log in oppure registratevi utilizzando il 
codice ricevuto da Noldus. Nell’area Downloads scegliete EthoVision 
XT > Sample Experiments. Questi esperimenti riguardano test specifici 
come l’Open field, l’interazione sociale, il Novel Object Recognition etc.

Corso in forma di video

In EthoVision XT, selezionate Help > Video Tutorial. Il video Vi mostra 
come impostare un esperimento in EthoVision XT.

In diverse parti del programma trovate dei video che vi mostrano come 
disegnare una arena, quale impostazioni di rilevamento scegliere, ecc. 
Per guardare questi video, cliccate l’icona sulla barra degli strumenti 
oppure nella finestra di dialogo aperta in quel momento.

Supporto tecnico

Se incontrate problemi, consultate la pagina internet my.noldus.com,  e 
nell’area Get support contattate il servizio di supporto.
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